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1. INTENDED USE

The BD OneFlow™ LST (Lymphoid Screening Tube) is intended for 
flow-cytometric immunophenotyping of normal and aberrant mature 
lymphocyte populations of B, T, and NK lineages in peripheral blood, 
bone marrow, and lymph nodes, as an aid in the diagnosis of 
hematological disorders. The BD OneFlow™ LST is designed for use 
with a suitably equipped BD flow cytometer and software designated 
for in vitro diagnostic use.

2. SUMMARY AND EXPLANATION

In chronic lymphoproliferative disorders (CLPD), clonogenic events 
lead to the expansion and accumulation of mature-appearing 
lymphocytes, which carry a proliferative and/or survival advantage 
over their normal counterparts.1 Thus, the detection of phenotypically 
aberrant and clonal mature lymphocytes is critical to the diagnosis of 
CLPD.

The EuroFlow™* Consortium designed multicolor antibody panels to 
fully characterize the cell populations in a patient specimen using 
immunophenotypic markers that are indicative of normal and 
abnormal cells.1 In addition to the optimized multicolor antibody 
panels, the EuroFlow protocol comprises standardized procedures for 
cytometer setup, determination of assay settings, sample preparation 
and staining, sample acquisition, and data analysis.2

The single-tube screening panels and multi-tube classification panels fit 
into the EuroFlow diagnostic algorithm for the identification and 
classification of hematological disorders. Each tube contains a set of 
backbone markers and a set of classification markers.1 Backbone 
markers are shared across a particular set of panels and are used to 
normalize the samples so that data files can be combined and analyzed 

* The EuroFlow trademark and logo and the EuroFlow™ antibody panels are property 
of the EuroFlow Consortium and cannot be reproduced or published without prior 
written permission from the EuroFlow coordinator (www.euroflow.org).

http://www.euroflow.org
http://www.euroflow.org
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as a single large data file. They are markers that identify distinct cell 
populations in a particular cell lineage. Classification markers have 
been selected for their diagnostic utility in discriminating between cell 
types within a given lineage and in classifying the abnormal cell type in 
the sample.

3. PRINCIPLES OF THE PROCEDURE

Multiparameter flow cytometry is a sensitive and rapid tool for the 
qualitative and quantitative characterization of cell populations in a 
specimen. Cells are incubated with fluorochrome-conjugated 
antibodies which bind to their target molecules. The stained cells can 
then be analyzed on a single-cell basis. Multiparameter analysis of the 
data is used to identify the cell populations in the patient specimen and 
can lead to the identification of an aberrant clonal cell population.

The number of parameters used in flow cytometric 
immunophenotyping of hematological disorders has increased in recent 
years. BD OneFlow™ LST contains a panel of fluorochrome-
conjugated antibodies that identify normal and aberrant populations of 
B, T, and NK lymphocytes. Analysis of the dot plots allows for the 
identification of normal and abnormal cell populations.

4. REAGENT 

Reagent Composition

BD OneFlow™ LST consists of single-use tubes containing the 
following fluorochrome-conjugated antibodies in an optimized dried 
formulation. See Table 1.

Table 1 BD OneFlow™ LST antibody panel

Antibody Fluorochrome Clone Isotype

CD8 FITC SK1 (Leu2a)3 IgG1, κ
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The antibodies in BD OneFlow™ LST were chosen for their ability to 
separate normal lymphocytes into their major subpopulations.

CD45 identifies mature lymphocytes and B-cell precursors.

CD3 identifies T cells. CD3 can also be used to identify B cells and 
NK cells by exclusion.

Anti-TCRγ/δ-1, CD5, CD4, and CD8 can separate T cells into a 
number of subpopulations.

Anti-Lambda FITC 1-155-24 IgG1, κ

CD56 PE MY31 (Leu-19)5,6 IgG1, κ

Anti-Kappa PE TB28-24 IgG1, κ

CD5 PerCP-Cy™5.5a L17F127,8 IgG2a, κ

CD19 PE-Cy™7 SJ25-C19,10 IgG1, κ

Anti–TCRγ/δ-1 PE-Cy7 11F211,12 IgG1, κ

CD3 APC SK78 IgG1, κ

CD38 APC-H7 HB79 IgG1, κ

CD4 V450b SK3 (Leu3a)3 IgG1, κ

CD20 V450 L279 IgG1, κ

CD45 V500-Cb 2D113,14 IgG1, κ

a. Cy™ is a trademark of GE Healthcare. This product is subject to proprietary rights of GE Healthcare 
and Carnegie Mellon University, and is made and sold under license from GE Healthcare. This 
product is licensed for sale only for in vitro diagnostics. It is not licensed for any other use. If you 
require any additional license to use this product and do not have one, return this material, 
unopened, to BD Biosciences, 2350 Qume Drive, San Jose, CA 95131, and any money paid for the 
material will be refunded.

b. BD Horizon™ V450, BD Horizon™ V500-C

Table 1 BD OneFlow™ LST antibody panel

Antibody Fluorochrome Clone Isotype
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CD19 and CD20 identify B cells, and together with CD45 can separate 
B cells into mature B lymphocytes (CD19+, CD20hi, CD45hi) and B-cell 
precursors (CD19+, CD20–/lo, CD45lo). CD19 and CD20 are also used 
to identify NK cells by exclusion.

Anti-Kappa and Anti-Lambda can identify normal and clonally 
expanded populations of B cells expressing Igκ or Igλ on the surface 
membrane, respectively.

CD38 identifies plasma cells and B-cell precursors. In addition, it is 
informative in the evaluation of a wide variety of lymphoid 
malignancies. CD38 can also aid in the identification of NK cells.

CD56 identifies NK cells.

Refer to the article describing the EuroFlow antibody panels1 for a full 
description of the utility of the antibodies chosen for BD OneFlow™ 
LST.

Precautions

• The reagent contains 0.25 – <1% of 5-chloro-2-methyl-4-
isothiazolin-3-one and 2-methyl-4-isothiazolin-3-one (3:1) (CAS 
number 2682-20-4) and 0.1 – <0.25% of sodium azide (CAS 
number 26628-22-8). The reagent is classified as hazardous 
according to the Globally Harmonized System of Classification 
and Labelling of Chemicals (GHS). Go to regdocs.bd.com to 
download the Safety Data Sheet.

Warning

H317: May cause an allergic skin reaction. 
H412: Harmful to aquatic life with long lasting effects.

http://regdocs.bd.com/regdocs/searchSDS.do
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Storage and Handling

Store tubes at 2°C–27°C in the foil pouch. Do not freeze the reagent or 
expose it to direct light at any time during storage or incubation with 
cells. The dried fluorochrome-conjugated antibodies are stable until the 
expiration date shown on the pouch and tube labels when stored as 
directed. Do not use after the expiration date. Once the pouch is 
opened, the dried fluorochrome-conjugated antibodies are stable for 
one month when stored as directed.

CAUTION Ensure the pouch is completely resealed after removing a 
tube. The reagent is very sensitive to moisture. Do not remove the 
desiccant from the reagent pouch.

Prevention P261: Avoid breathing dust/fume/gas/mist/vapors/spray.
P272: Contaminated work clothing should not be allowed out of 
the workplace.
P280: Wear protective gloves/protective clothing/eye protection/
face protection.
P273: Avoid release to the environment.

Response P302+P352: IF ON SKIN: Wash with plenty of water/...
P333+P313: If skin irritation or rash occurs: Get medical advice/
attention.
P321: Specific treatment (see Safety Data Sheet).
P363: Wash contaminated clothing before reuse.

Disposal P501: Dispose of contents/container to an appropriate treatment 
and disposal facility in accordance with applicable laws and 
regulations, and product characteristics at time of disposal.

Warning
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5. INSTRUMENTS

BD OneFlow™ LST is for use on the following BD instruments.

The BD FACS™ Universal Loader can be used with this product. See 
the BD FACSLyric™ Clinical System Instructions For Use for more 
information. The Loader can be used with BD FACSuite™ Clinical 
application v1.5 or later.

6. SPECIMENS

BD OneFlow™ LST can be used for immunophenotyping by flow 
cytometry of peripheral blood (PB) or bone marrow (BM) aspirates 
collected in EDTA or heparin15-18,21-23 (for example, BD Vacutainer® 
blood collection tubes), and fresh lymph nodes (LN) collected in PBS or 
cell culture media, such as RPMI. Each type of specimen can have 
different storage conditions and limitations that should be considered 
prior to collection and analysis.15,16,21 

Table 2 Recommended BD instruments

Flow cytometer Setup beads Setup software Analysis software

BD FACSLyric™a

a. 8-color (4-Blue 2-Red 2-Violet), 10-color (4-Blue 3-Red 3-Violet), or 12-color (4-Blue 3-Red 5-Violet)

BD® CS&T Beads
BD® FC Beads 7-Color 
Kit
BD® FC Beads 5-Color 
Kit

BD FACSuite™ 
Clinical application 
v1.4 or later

BD FACSuite™ 
Clinical application 
v1.4 or later

BD FACSCanto™ IIb

b. 3-laser, 8-color, 4-2H-2V BD default (4-2H-2V) optical configuration

BD FACSDiva™ CS&T 
IVD Beads
BD OneFlow™ Setup 
Beads
BD® FC Beads 8-Color 
Kit for BD OneFlow™ 
Assays

BD FACSDiva™ 
software v8.0.1 or 
later

BD FACSDiva™ 
software v8.0.1 or 
later
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Specimens should be processed immediately after collection, or up to 
24 hours after collection if stored at room temperature (20°C–
25°C).17,18,22,23 If a longer period of time is needed, each laboratory 
should validate that specimens processed and stored according to their 
procedures produce equivalent results to specimens processed 
immediately after collection. 

Specimens with large numbers of nonviable cells can give erroneous 
results due to selective loss of populations and to increased nonspecific 
binding of antibodies to nonviable cells. Viability of specimens should 
be assessed and a cutoff value established. A cutoff value of at least 
80% viable cells has been suggested.15

Samples should be acquired within 60 minutes if kept at room 
temperature, protected from light. If a longer period of time is needed, 
each laboratory should validate that stained specimens acquired after 
being held under their storage conditions produce equivalent results to 
specimens acquired immediately after staining. Protect stained 
specimens from light until they are acquired.

WARNING All biological specimens and materials coming in contact 
with them are considered biohazards. Handle as if capable of 
transmitting infection19,20 and dispose of with proper precautions in 
accordance with federal, state, and local regulations. Never pipette by 
mouth. Wear suitable protective clothing, eyewear, and gloves.

7. REAGENTS AND MATERIALS

Reagents Provided

BD OneFlow™ LST is provided as single-use tubes in foil pouches. 
Each kit contains four pouches, each containing five tubes of 
BD OneFlow™ LST.
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Reagents and Materials Required but Not Provided

For BD FACSLyric™ flow cytometers:

• BD OneFlow™ Assays Installer I (Catalog No. 664225)

An installer is required for the BD OneFlow™ LST assay. If you 
are using the Loader, use BD OneFlow™ Assays Installer I v1.1 to 
install the assay in BD FACSuite™ Clinical application v1.5 or 
later. The assay comprises an acquisition sheet, a laboratory report, 
a physician report, and a supplemental report used for further 
investigation. Unless you already have the current OneFlow LST 
assay, you will have to order the installer the first time you order 
BD OneFlow™ LST. The installer also contains assays for other 
BD OneFlow™ reagents.

The BD OneFlow™ LST Application Guide for BD FACSLyric™ 
Flow Cytometers is provided with the installer. Application guides 
for other BD OneFlow™ reagents are also included.

For BD FACSCanto™ II flow cytometers:

• BD OneFlow™ Assay Templates Installer (Catalog No. 659305)

An installer is required for the BD OneFlow™ LST template. The 
template contains two global worksheets: the BD OneFlow™ LST 
Acquisition worksheet and the BD OneFlow™ LST Analysis 
worksheet. Unless you already have the current BD OneFlow™ 
LST template, you will have to order the installer the first time you 
order BD OneFlow™ LST. The installer also contains the 
OneFlow Setup template and templates for other BD OneFlow™ 
reagents.

The Instrument Setup Guide for BD OneFlow™ Assays and the 
BD OneFlow™ LST Application Guide are provided with the 
installer. Application guides for other BD OneFlow™ reagents are 
also included.

• 15-mL conical polypropylene tubes



13

• Pasteur pipet
• Serological pipet
• Micropipettor with tips
• Vortex mixer
• Centrifuge
• Wash buffer (filtered PBS + 0.5% BSA + 0.09% or 0.1% sodium 

azide)
• BD FACS™ Lysing Solution (10X) (Catalog No. 349202)

See the BD FACS™ Lysing Solution instructions for use (IFU) for 
precautions and warnings.

For BD FACSLyric™ flow cytometers:

• BD® CS&T Beads (Catalog No. 656504 or 656505)
• BD® FC Beads 7-Color Kit (Catalog No. 656867)
• BD® FC Beads 5-Color Kit (Catalog No. 661564)

For BD FACSCanto™ II flow cytometers:

• BD FACSDiva™ CS&T IVD Beads (Catalog No. 656046 or 
656047)

• BD OneFlow™ Setup Beads (Catalog No. 658620)
• BD® FC Beads 8-Color Kit for BD OneFlow™ Assays 

(Catalog No. 658621)

8. PROCEDURE

Installing the Assay or Template

The BD OneFlow™ LST assay, used with BD FACSuite™ Clinical 
application, or the BD OneFlow™ LST template, used with 
BD FACSDiva™ software, has to be installed before you run the assay 
for the first time. Additional assays or templates can be installed at the 
same time, as needed. If you will analyze the FCS files on a different 
workstation from the one used to acquire the samples, ensure that you 
install the assays or templates on both workstations.
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To install the BD OneFlow™ assay in BD FACSuite™ Clinical 
application:

NOTE When you select an assay to install, it will overwrite the 
BD OneFlow™ LST assay that was previously installed on the system. 
If you do not want an existing assay on your computer to be 
overwritten, do not select that assay from the installer during the 
installation process.

1. Insert the installer and click the installer icon.

The InstallShield Wizard for BD OneFlow™ Assays opens.

2. Click Next.

The license agreement opens.

3. Select the I accept the terms in the license agreement option and 
click Next.

4. To install all of the assays included on the installer, select the 
Complete option and click Next.

5. Optional: To install a subset of the assays included on the installer, 
select the Custom option and click Next.

The Custom Setup dialog opens.

• Click the menu to the left of the appropriate assay.
• From the menu, select This assay will be installed on your local 

hard drive.

6. Click Install.

The assays will be installed in the Library.

7. Click Finish.

The InstallShield Wizard closes.
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8. Optional: Double-click the ReadMe file found on the installer.

The ReadMe file opens.

9. Click the close box when finished reading it.

10. Remove the installer.

To install the OneFlow template in BD FACSDiva™ software:

NOTE When you select a template to install, it will always overwrite 
any template with the same name that was previously installed on the 
system. If you do not want an existing template on your computer to 
be overwritten, do not select that template from the installer during the 
installation process.

1. Insert the installer and click the installer icon.

2. Follow the instructions in the dialog.

The installer will copy and paste the templates in the folder 
D:\BDExport\Templates\Panel\BD Panels.

NOTE If your system has only one drive, the templates will be 
installed in C:\BDExport\Templates\Panel\BD Panels.

After installation is complete, a dialog opens, summarizing which 
templates have been successfully copied into the folder.

3. Click OK to close the dialog.

4. The installer ReadMe file opens. Click the close box when you 
have finished reading it.

5. Remove the installer.

Setting up the Cytometer

For BD FACSLyric™ flow cytometers:

1. Use BD® CS&T Beads and BD FACSuite™ Clinical application 
v1.4 or later, to perform Characterization QC (CQC) every 
6 months or as needed, perform daily Performance QC (PQC), and 
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perform daily assay and tube settings setup. For assay and tube 
settings setup, select the Run Setup and Generate Reports 
checkboxes.

2. Use the BD® FC Beads 7-Color Kit, BD® FC Beads 5-Color Kit, 
and BD FACSuite™ Clinical application v1.4 or later, to update 
reference settings every 60 days.

See the BD FACSLyric™ Clinical System Instructions For Use, the 
BD FACSLyric™ Clinical Reference System, and the appropriate 
reagent IFU for more information.

For BD FACSCanto™ II flow cytometers:

1. Use BD FACSDiva™ CS&T IVD Beads (CS&T IVD beads) and 
BD FACSDiva™ software v8.0.1 or later, to define the baseline of 
the cytometer and to run a daily performance check of the 
cytometer. 

2. Use BD OneFlow™ Setup Beads, lysed washed blood, and 
BD FACSDiva™ software v8.0.1 or later, to set photomultiplier 
tube (PMT) and scatter voltages monthly. 

3. Use BD® FC Beads and BD FACSDiva™ software v8.0.1 or later, 
to set fluorescence compensation monthly.

4. We recommend that you confirm that the PMT voltages (PMTVs) 
are still within their daily target ranges.

See the Instrument Setup Guide for BD OneFlow™ Assays and the 
appropriate reagent IFU for more information.

Diluting BD FACS™ Lysing Solution

Dilute the 10X concentrate 1:10 with room temperature (20°C–25°C) 
deionized water. The prepared solution is stable for 1 month when 
stored in a glass or high density polyethylene (HDPE) container at 
room temperature.
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Processing the Specimen

Washing the specimen

NOTE Before washing the specimen, confirm that the cytometer has 
been properly set up.

1. Label a 15-mL conical tube with the specimen ID.

2. Invert the specimen in the collection tube 10 times to mix well.

3. Add 300 µL of the specimen to the labeled conical tube.

4. Add 10 mL of wash buffer (filtered PBS + 0.5% BSA + 0.09% or 
0.1% sodium azide).

5. Invert the tube 3–5 times to mix well.

6. Centrifuge at 540g for 5 minutes at 20°C–25°C.

7. Remove the supernatant without disturbing the cell pellet.

8. Vortex the tube until no cell aggregates remain before adding wash 
buffer.

9. Repeat steps 4–8 twice for a total of three washes.

10. Resuspend the cell pellet in 200 µL of wash buffer to give a final 
volume of approximately 300 µL.

NOTE Start staining the specimen using BD OneFlow™ LST 
within 30 minutes of the last wash. Store the washed specimen at 
20°C–25°C until you stain it.

Staining the specimen

1. If the pouch is stored refrigerated, allow it to reach room 
temperature before opening it.

NOTE The reagent is very sensitive to moisture. To avoid 
condensation, open the pouch only if it is at room temperature.
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2. For each patient specimen, remove a BD OneFlow™ LST tube 
from the pouch.

3. Place the tubes in a rack, protected from light.

Start staining the specimen within one hour of removing a tube 
from the pouch.

4. Immediately reseal the pouch with any unused tubes.

NOTE Ensure the pouch is completely resealed after removing a 
tube. The reagent is very sensitive to moisture. Do not remove the 
desiccant from the reagent pouch.

5. Write the patient ID on the BD OneFlow™ LST tube label within 
the area provided.

NOTE Write the current date on the pouch label when it is first 
opened. Use the tubes from that pouch within one month before 
opening the next pouch.

6. Vortex washed specimen 3–5 seconds to mix well.

7. Add 100 µL of washed specimen to the tube. Vortex vigorously 3–
5 seconds to mix well.

If less than 100 µL of specimen is used, add wash buffer to a final 
volume of 100 µL.

NOTE Do not wipe the outside of the tube with ethanol or 
isopropanol because the ink on the printed label can run.

8. Incubate for 30 minutes at 20°C–25°C, protected from light.

9. Add 2 mL of 1X BD FACS™ Lysing Solution. Vortex 3–5 seconds 
to mix well.

10. Incubate for 10 minutes at 20°C–25°C, protected from light.

11. Centrifuge at 540g for 5 minutes at 20°C–25°C.
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12. Remove the supernatant without disturbing the cell pellet, leaving 
approximately 50 µL of residual liquid in the tube.

13. Vortex vigorously until the cell pellet is completely resuspended.

14. Add 2 mL of wash buffer to the tube. Vortex 3–5 seconds to mix 
well.

15. Centrifuge at 540g for 5 minutes at 20°C–25°C.

16. Remove the supernatant without disturbing the cell pellet, leaving 
approximately 50 µL of residual liquid in the tube.

17. Vortex 3–5 seconds to resuspend the cell pellet.

18. Add 200 µL of wash buffer to the tube. Vortex 3–5 seconds to mix 
well.

NOTE Samples should be acquired within 60 minutes if kept at 
room temperature, protected from light. If a longer period of time 
is needed, each laboratory should validate that stained specimens 
acquired after being held under their storage conditions produce 
equivalent results to specimens acquired immediately after 
staining. Protect stained specimens from light until they are 
acquired.

Setting up the Assay (BD FACSLyric™ Flow Cytometer)

To add a reagent lot ID and expiration date to the library:

1. From the BD FACSuite™ Clinical application navigation bar, click 
the Library icon.

The Library workspace opens.

2. Expand the Beads and Reagents menu and select Reagents.

3. Select OneFlow LST from the Product Name list.

The OneFlow LST pane opens at the bottom of the page.
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4. Click Add Lot.

The Add New Lot dialog opens.

5. In BD FACSuite™ Clinical application v1.5, click Scan Barcode 
and then scan the barcode on the pouch or tube label.

The Lot ID and expiration date are entered in the appropriate 
fields.

NOTE In BD FACSuite™ Clinical application v1.4, add the Lot ID 
and expiration date manually.

6. Select the Current Lot checkbox.

7. Click OK.

The lot ID and expiration date are added to the appropriate 
columns for the reagent. 

NOTE Make sure to add the reagent lot and expiration date prior 
to acquisition. This has to be done only once for a particular 
reagent lot.

To create a worklist:

1. From the BD FACSuite™ Clinical application navigation bar, click 
the Worklists icon.

The Worklists workspace opens.

2. In the Manage Worklists tab, click New.

A blank worklist opens in a new tab.

3. In the Worklist Entries section, select the appropriate task from the 
Task menu.
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4. Enter the Sample ID for BD OneFlow™ reagent tasks.

Do not scan the barcode, found on the tube label, into the 
software.

NOTE Multiple lots of the same reagent cannot be run on the same 
worklist.

5. In the Loading Options section, select Manual or Universal Loader 
from the Loading Option menu.

6. If using the Loader, select 30 Tube Rack or 40 Tube Rack from the 
Carrier Type menu.

See the BD FACSLyric™ Clinical System Instructions For Use for 
more information.

Setting up the Experiment (BD FACSCanto™ II Flow Cytometer)

1. From the menu bar, select Edit > User Preferences, then navigate to 
the FCS tab, and select Export FCS after recording, to 
automatically export the FCS files after acquisition. Click OK.

2. Confirm that the cytometer is in the default 4-2H-2V 
configuration.

3. From the menu bar, select Experiment > New Experiment > Blank 
Experiment. Click OK.

NOTE You can also create an experiment directly from the 
Browser using the Experiment icon.

4. If prompted by the CST Mismatch window, select Use CST 
Settings.

5. Rename the experiment according to your laboratory practice.
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6. In the Browser, right-click Cytometer Settings > Link Setup and 
select the appropriate compensation matrix calculated using 
BD® FC Beads within the past 31 days. Click Link. 

See the BD® FC Beads 8-Color Kit for BD OneFlow™ Assays IFU 
or the Instrument Setup Guide for BD OneFlow™ Assays.

7. If prompted by the Cytometer Settings Mismatch window, select 
Overwrite.

8. Right-click Cytometer Settings > Unlink From the previously 
linked compensation setup. Click OK.

NOTE Unlinking the compensation setup allows updated 
application settings to be applied while retaining compensation 
values.

9. In the Browser, right-click Cytometer Settings > Application 
Settings > Apply and select the most recent application settings 
determined within the last 31 days using the BD OneFlow™ Setup 
Beads. Click Apply.

10. A Confirm dialog opens. Select Keep the compensation value.

11. If prompted by the Confirm Cytometer Changes dialog, click Yes 
to overwrite the cytometer values for FSC Area Scaling.

12. From the menu bar, select Experiment > New Specimen.

The Panel Templates dialog opens. 

13. Navigate to the BD Panels tab and select the OneFlow LST 
template.

14. Indicate the number of patient specimens you want to acquire 
using the Copies field near the bottom of the BD Panels tab. Click 
OK.
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15. Rename each specimen, for example, with the appropriate patient 
ID in front of the specimen name.

NOTE If you have to re-run a particular patient sample, set the 
current tube pointer to the tube you wish to re-run. Click Next 
Tube in the Acquisition Dashboard to create another tube for that 
patient. Do not select Experiment > New Tube from the menu bar 
or use the New Tube icon from the Browser menu bar to create the 
additional tube to be acquired because the labels and barcode 
fields will not be populated.

NOTE If you want to acquire additional patient samples stained 
with BD OneFlow™ LST in the experiment, repeat steps 12–15 to 
add new specimens. Two Confirm dialogs will open asking if you 
want to create another LST acquisition worksheet or another LST 
analysis worksheet. Click Cancel in each dialog.

16. From the menu bar, select Experiment > Experiment Layout and 
navigate to the Keywords tab.

17. Highlight the Product ID keyword for the appropriate tube, and 
scan the barcode on the BD OneFlow™ LST tube label.

NOTE If you cannot scan the barcode on the tube label, see 
Troubleshooting.

18. Manually add the appropriate information to the remaining 
keywords, as needed.

19. Click OK to close the Experiment Layout.
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Acquiring the Stained Sample

For BD FACSLyric™ flow cytometers:

Two versions of the assay are available:

The assay will automatically collect 100,000 total events. You cannot 
append the number of events to collect after acquisition has started. 
Therefore, if needed, change the number of events to collect before you 
start acquisition. To change the number of events to collect, see the 
BD OneFlow™ LST Application Guide for BD FACSLyric™ Flow 
Cytometers. A clinically relevant number of cells can be determined at 
the discretion of an appropriate healthcare professional.

To acquire the sample using BD OneFlow™ LST assay v1.1:

1. In the Worklist Controls bar, select Run All from the Run menu to 
run the entire worklist from the beginning.

Alternatively, to acquire a specific tube, set the run pointer to the 
sample you want to run and select Run from Pointer from the Run 
menu.

2. Vortex each stained tube 3–5 seconds at low speed immediately 
prior to acquisition.

If using the BD FACS™ Universal Loader, vortex tubes 
immediately before placing them in the Loader racks.

NOTE Make sure that all of the BD OneFlow™ tubes in the rack 
are acquired within 1 hour. If not, you must validate tubes 
acquired outside the 1 hour time.

Assay version Software Stopping time Acquisition mode

v1.0 BD FACSuite™ Clinical 
application v1.4 or later

5 minutes Manual

v1.1 BD FACSuite™ Clinical 
application v1.5 or later

3 minutes Manual, Loader
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3. Follow the prompts in the software to load or unload tubes.

The BD OneFlow™ LST Acquisition sheet opens. The acquisition 
sheet contains dot plots and gates to identify Leukocytes, 
Lymphocytes, B cells, T cells, NK cells, and their relevant 
subpopulations.

4. Examine each dot plot on the acquisition sheet.

NOTE  The preview time is 10 seconds and then data is 
automatically recorded. Do not increase the preview time and risk 
loss of the sample due to insufficient volume.

NOTE The assay will automatically collect 100,000 total events. If 
the assay cannot collect 100,000 total events, acquisition will stop 
after 3 minutes. A QC message, “All Events gate does not contain 
the requested 100,000 events” is generated in the Lab Report, and 
can be ignored if the sample can be analyzed using the events 
acquired. 

See the BD FACSLyric™ Clinical System Instructions For Use for 
more information.

To acquire the sample using BD OneFlow™ LST assay v1.0:

1. In the Worklist Controls bar, select Run All from the Run menu to 
run the entire worklist from the beginning.

Alternatively, to acquire a specific tube, set the run pointer to the 
sample you want to run and select Run from Pointer from the Run 
menu.

2. Vortex each stained tube 3–5 seconds at low speed immediately 
prior to acquisition.

3. Follow the prompts in the software to load or unload tubes.

The BD OneFlow™ LST Acquisition sheet opens. The acquisition 
sheet contains dot plots and gates to identify Leukocytes, 
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Lymphocytes, B cells, T cells, NK cells, and their relevant 
subpopulations.

4. Examine each dot plot on the acquisition sheet.

NOTE  The preview time is 10 seconds and then data is 
automatically recorded. Do not increase the preview time and risk 
loss of the sample due to insufficient volume.

5. If it appears that fewer than 100,000 events will be collected, 
monitor the sample volume and click Stop Tube in the Worklist 
Controls bar to stop acquisition before the tube runs dry.

NOTE The assay will automatically collect 100,000 total events. If 
the assay cannot collect 100,000 total events, acquisition will stop 
after 5 minutes. However, make sure you monitor the sample 
volume and click Stop Tube in the Worklist Controls bar to stop 
acquisition before the tube runs dry. To change the stopping 
criteria, see the BD OneFlow™ LST Application Guide for 
BD FACSLyric™ Flow Cytometers.

See the BD FACSLyric™ Clinical System Instructions For Use for 
more information.

For BD FACSCanto™ II flow cytometers:

1. In the Browser, expand the appropriate specimen and set the 
current tube pointer to that tube.

2. Select the BD OneFlow™ LST Acquisition worksheet tab.

3. Vortex the stained tube 3–5 seconds at low speed.

4. Install the tube on the cytometer. Adjust the flow rate to Medium 
in the Acquisition Dashboard. Click Acquire Data.

5. Verify that the population is on scale and adjust the gate in the first 
plot of the acquisition worksheet to exclude debris, if needed.
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6. Click Record Data in the Acquisition Dashboard to collect total 
events.

NOTE The template will automatically collect 100,000 total 
events. Use the menu in the Acquisition Dashboard to select a 
different number of events to acquire, if needed. A clinically 
relevant number of cells can be determined at the discretion of an 
appropriate healthcare professional.

7. Inspect the dot plots on the acquisition worksheet and adjust the 
gates as needed.

Some of the dot plots might look different from those in other 
experiments. The initial FSC-A vs SSC-A dot plot to identify cells 
and eliminate debris may appear compressed. This is a 
consequence of the target values used to create the application 
settings. The values are specified by the EuroFlow Consortium.

NOTE Enlarge the dot plots while adjusting the gates so you can 
more readily see the populations of interest. After adjusting the 
gates, collapse the dot plot to its original size.

The FSC-A vs SSC-A dot plot is used to identify cells.

The CD45 V500-A vs SSC-A dot plot contains two gates to 
identify leukocytes and lymphocytes. T cells and B cells are 
identified in the CD3 APC-A vs CD19+TCRgd PE-Cy7-A dot plot 
from the lymphocyte population.

T cells are divided into TCRγ/δ+ and TCRγ/δ– populations in the 
CD3 APC-A vs CD19+TCRgd PE-Cy7-A dot plot from the T-cell 
population. TCRγ/δ– cells are divided into CD8+CD4– and 
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CD4+CD8– populations in the CD20+CD4 V450-A vs CD8+IgL 
FITC-A dot plot.

Igκ- and Igλ-expressing B cells are identified in the CD56+IgK 
PE-A vs CD8+IgL FITC-A dot plot from the B-cell population.

NK cells are identified from the NOT(T cells OR B cells) 
population in the CD45 V500-A vs CD56+IgK PE-A dot plot.

The remaining dot plots do not contain gates and are included to 
ensure that the antibodies can stain cells in the specimen, therefore 
serving as an internal quality control for the tube.

NOTE See the BD OneFlow™ LST Application Guide for 
examples of the dot plots showing populations of normal cells in 
the LST acquisition worksheet.

8. Acquire the next sample.

9. From the menu bar, select File > Export > Experiments, and select 
the Directory Export option. Click OK.

Analyzing the Data Using BD FACSuite™ Clinical Application

NOTE FCS files acquired using BD OneFlow™ LST assay v1.0 can be 
opened in BD OneFlow™ LST assay v1.1.

1. Set the run pointer to the appropriate sample in the Worklist 
Entries panel.

The BD OneFlow™ LST Laboratory Report opens in the 
Laboratory Report tab.

2. Review the BD OneFlow™ LST Laboratory Report.

The first page of the laboratory report shows sample and tube 
information, population statistics, and QC messages, if generated.

NOTE Populations with a low number of events might report 
%Parent or %Grandparent as 0.0%. This is due to rounding the 
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result to a single decimal place in BD FACSuite™ Clinical 
application.

3. Inspect the dot plots on page 2 of the laboratory report and adjust 
the gates as needed.

The gates in the dot plots of the laboratory report are provided for 
analyzing normal and aberrant cell populations in the specimen.

NOTE Enlarge the dot plots while adjusting the gates so you can 
more readily see the populations of interest. After adjusting the 
gates, collapse the dot plot to its original size.

The dot plots on page 2 of the report provide a high level cell 
analysis.

The first three dot plots on the report identify cells, FSC singlets, 
and SSC singlets. Debris and doublets are excluded by adjusting 
the gates.

Leukocytes and lymphocytes are identified in the CD45 V500-A vs 
SSC-A dot plot from the SSC Singlets population.

B cells (CD3–CD19+) and T cells (CD3+) are identified in the CD3 
APC-A vs CD19/TCRgd PE-Cy7-A dot plot from the Lymphocytes 
population.

TCRγδ+ T cells and TCRγδ– T cells are identified in the CD3 APC-
A vs CD19/TCRgd PE-Cy7-A dot plot from the T cells population.

See the BD OneFlow™ LST Application Guide for 
BD FACSLyric™ Flow Cytometers for examples of dot plots 
showing populations of normal cells.
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4. Inspect the dot plots on page 3 of the laboratory report and adjust 
the gates as needed.

The dot plots on page 3 of the laboratory report are used to 
analyze B cells. Examine the level of CD20 expression in the 
CD19/TCRgd PE-Cy7-A vs CD20/CD4 V450-A dot plot.

Examine the ratio of Igκ- to Igλ-expressing B cells in the CD56/IgK 
PE-A vs CD8/IgL FITC-A dot plot.

The remaining dot plots further characterize B cells using various 
markers.

5. Inspect the dot plots on page 4 of the laboratory report and adjust 
the gates as needed.

The dot plots on page 4 of the laboratory report identify various 
populations of T cells. TCRγ/δ– T cells are divided into 
CD4+CD8–, CD8+CD4–, CD4+CD8+, and CD4–CD8– populations 
in the CD20/CD4 V450-A vs CD8/IgL FITC-A dot plot.

The CD4+ and CD8+ populations of T cells might trail into the 
double positive quadrant instead of being discrete populations. 
This is a consequence of the panel of antibodies present in 
BD OneFlow™ LST.

The remaining dot plots further characterize TCRγ/δ– and TCRγ/δ+ 

cells using various markers.

6. Inspect the dot plots on page 5 of the laboratory report and adjust 
the gates as needed.

The dot plots on page 5 of the laboratory report identify NK cells. 
NK cells are identified from the NOT T cells OR B cells 
population in the CD45 V500-C-A vs CD56/IgK PE-A dot plot.

The remaining dot plots further characterize NK cells using 
various markers.
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7. Inspect page 6 of the laboratory report.

Page 6 of the laboratory report includes lot and expiration dates 
for BD® CS&T Beads and the BD OneFlow™ reagent, reference 
settings, tube settings, and cytometer configuration.

8. (Optional) Select the Physician Report tab to view the report.

The OneFlow LST Physician Report contains a high level summary 
of the assay results.

9. (Optional) Select the Supplemental Report tab to add additional 
dot plots to further analyze the sample.

See the BD OneFlow™ LST Application Guide for 
BD FACSLyric™ Flow Cytometers for more information.

WARNING Any gated regions deleted in this Supplemental Report 
are reflected in the Laboratory and Physician Reports. Any gated 
regions created in this Supplemental Report might be reflected in 
the Laboratory Report.

WARNING Do not add dot plots or gates to the Laboratory 
Report or Physician Report. They cannot be deleted and will 
invalidate the report.

10. Select the Laboratory Report tab.

11. Click E-sign.

The E-Signature dialog opens.

12. Select a user ID.

13. Type your password.

14. (Optional) Enter any comments.

15. Click Sign.

The dialog closes and the signer’s user ID, date and time, and 
comments are added to the E-signature box in all three reports.



32

16. Click Approve.

The Laboratory and Physicians Reports are automatically exported 
to C:\BD Export Clinical. If needed, manually export the 
Supplemental Report.

See the BD FACSLyric™ Clinical System Instructions For Use for 
more information and export options.

Analyzing the Data Using BD FACSDiva™ Software

1. From the menu bar, select File > Import > Experiments.

2. Select the experiment that you want to analyze. Click Import.

The experiment with the associated acquisition and analysis 
worksheets opens.

3. Select the BD OneFlow™ LST Analysis worksheet tab.

4. Inspect the dot plots on page 1 of the LST analysis worksheet and 
adjust the gates as needed.

Some of the dot plots might look different from those in other 
experiments. The initial FSC-A vs SSC-A dot plot to identify cells 
and eliminate debris may appear compressed. This is a 
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consequence of the target values used to create the application 
settings. The values are specified by the EuroFlow Consortium.

NOTE Enlarge the dot plots while adjusting the gates so you can 
more readily see the populations of interest. After adjusting the 
gates, collapse the dot plot to its original size.

The first three dot plots on the LST analysis worksheet identify 
cells, FSC singlets, and SSC singlets. Debris and doublets are 
excluded by adjusting the gates.

Examine the leukocyte and lymphocyte populations in the CD45 
V500-A vs SSC-A dot plot.

Examine the B-cell and T-cell populations in the CD3 APC-A vs 
CD19+TCRgd PE-Cy7-A dot plot from the lymphocyte 
population. Examine the TCRγ/δ+ and TCRγ/δ– populations in the 
CD3 APC-A vs CD19+TCRgd PE-Cy7-A dot plot from the T-cell 
population. The CD38 APC-H7-A vs SSC-A dot plot is included 
for informational purposes to allow for the visualization of CD38+ 
cells.

NOTE See the BD OneFlow™ LST Application Guide for 
examples of dot plots showing populations of normal cells.

5. Inspect the dot plots on page 2 of the LST analysis worksheet and 
adjust the gates as needed.

The dot plots on page 2 of the analysis worksheet identify various 
populations of T cells. TCRγ/δ– T cells are divided into 
CD8+CD4–, CD4+CD8+, CD4+CD8–, and CD4–CD8– populations 
in the CD20+CD4 V450-A vs CD8+IgL FITC-A dot plot.

The remaining dot plots further characterize TCRγ/δ– and TCRγ/δ+ 
cells using various markers.
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6. Inspect the dot plots on page 3 of the LST analysis worksheet and 
adjust the gates as needed.

The dot plots on page 3 of the analysis worksheet identify B cells. 
B cells are initially identified as being CD3–CD19+CD45+. 
Examine the level of CD20 expression in the CD19+TCRgd 
PE-Cy7-A vs CD20+CD4 V450-A dot plot.

Examine the ratio of Igκ- to Igλ-expressing B cells in the 
CD56+IgK PE-A vs CD8+IgL FITC-A dot plot.

The remaining dot plots further characterize B cells using various 
markers.

7. Inspect the dot plots on page 4 of the LST analysis worksheet and 
adjust the gates as needed.

The dot plots on page 4 of the analysis worksheet identify NK 
cells. NK cells are identified from the NOT(T cells OR B cells) 
population in the CD45 V500-A vs CD56+IgK PE-A dot plot.

The remaining dot plots further characterize NK cells using 
various markers.

8. Examine the results in the statistics box on page 5 of the LST 
analysis worksheet.

Confirm that all of the keywords are present in the statistics box. If 
any of the keywords are missing, see Troubleshooting.

9. Perform further analyses as needed.

NOTE The gates in the dot plots of the LST analysis worksheet are 
provided for analyzing normal and aberrant cell populations in the 
specimen.

10. Save the LST analysis worksheet as a PDF.

NOTE The analysis worksheet is a global worksheet. Any gates 
that are adjusted when analyzing a sample on a global worksheet 
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will be changed in previously analyzed files. Previously saved PDFs 
won’t change, but if you go back to a previously analyzed global 
worksheet, you will have to readjust the gates so they match what 
they were before.

11. (Optional) Click Print to print the LST analysis worksheet.

12. Analyze the next sample.

9. LIMITATIONS

• Use of therapeutic monoclonal antibodies in patient treatment can 
interfere with recognition of target antigens by this reagent. This 
should be considered when analyzing samples from patients 
treated in this fashion. BD Biosciences has not characterized the 
effect of the presence of therapeutic antibodies on the performance 
of this reagent.

• Use of this reagent for diagnostic evaluation of hematologic 
disorders should be performed in the context of a thorough 
immunophenotypic analysis including other relevant markers.

• Use of BD OneFlow™ LST requires experience with leukemia and 
lymphoma immunophenotyping and classification. The results 
should be interpreted by a pathologist, or equivalent professional, 
in conjunction with other clinical or laboratory findings.

• BD OneFlow™ LST has not been tested on specimens from 
patients with minimal residual disease (MRD).

• Avoid using potentially compromised specimens, including clotted, 
hemolyzed, frozen, or refrigerated specimens.
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10. PERFORMANCE CHARACTERISTICS

BD FACSLyric™ Flow Cytometer

Precision studies for the reproducibility and repeatability of 
BD OneFlow™ LST were performed at BD Research Centre Ireland.

Reproducibility and repeatability (BD FACSLyric™ flow cytometer)

A 5-day study was performed at one site to assess the reproducibility 
and repeatability of BD OneFlow™ LST using control material. 
Estimates of precision were determined across three BD FACSLyric™ 
flow cytometers and three operators by acquiring BD Multi-Check™ 
Control, stained in duplicate by each operator using three lots of 
BD OneFlow™ LST. Two separate runs were performed by each 
operator on each of the 5 tested days.

Nine cell populations were identified as being a percentage of the cell 
populations indicated in the following tables. The tables present the 
mean, standard deviation (SD), coefficient of variation (%CV), and the 
upper 95% confidence limit (CL) for reproducibility (operator/
instrument-to-operator/instrument, lot-to-lot, run-to-run, and 
day-to-day reproducibility) and repeatability (within-run precision) for 
each subset percentage.

Table 3 Reproducibility of subset percentages

Subset Mean SD
Upper 95% 

CL of SD %CV
Upper 95% 
CL of %CV

Leukocytes (%SSC 
Singlets)

99.78 0.13 0.15 0.14 0.15

Lymphocytes 
(%Leukocytes)

36.56 0.94 1.08 2.58 2.90

T cells (%Lymphocytes) 68.48 1.11 1.26 1.61 1.81

CD4+CD8– cells 
(%T cells)

66.05 0.30 0.34 0.45 0.50
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CD8+CD4– cells 
(%T cells)

29.66 0.39 0.44 1.31 1.47

B cells (%Lymphocytes) 12.99 0.34 0.39 2.62 2.95

NK cells 
(%Lymphocytes)

17.48 1.01 1.16 5.80 6.53

IgK cells (%B cells) 62.57 1.11 1.27 1.78 2.00

IgL cells (%B cells) 33.57 1.53 1.75 4.56 5.12

Table 4 Repeatability of subset percentages

Subset Mean SD
Upper 95% 

CL of SD %CV
Upper 95% 
CL of %CV

Leukocytes (%SSC 
Singlets)

99.78 0.04 0.05 0.04 0.05

Lymphocytes 
(%Leukocytes)

36.56 0.55 0.63 1.50 1.69

T cells (%Lymphocytes) 68.48 0.47 0.54 0.69 0.78

CD4+CD8– cells 
(%T cells)

66.05 0.35 0.40 0.53 0.59

CD8+CD4– cells 
(%T cells)

29.66 0.35 0.40 1.18 1.32

B cells (%Lymphocytes) 12.99 0.24 0.28 1.88 2.11

NK cells 
(%Lymphocytes)

17.48 0.34 0.38 1.93 2.16

IgK cells (%B cells) 62.57 1.09 1.25 1.75 1.96

IgL cells (%B cells) 33.57 1.16 1.33 3.47 3.89

Table 3 Reproducibility of subset percentages

Subset Mean SD
Upper 95% 

CL of SD %CV
Upper 95% 
CL of %CV
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Method comparison (BD FACSLyric™ flow cytometer)

A method comparison study between the BD OneFlow™ system on the 
BD FACSLyric™ flow cytometer (Investigational Method) and the 
BD OneFlow™ system on the BD FACSCanto™ II flow cytometer 
(Comparator Method) was performed at 4 clinical sites. The 
BD OneFlow™ system on BD FACSLyric™ comprises BD® CS&T 
Beads, BD® FC Beads 7-Color Kit, BD® FC Beads 5-Color Kit, and 
BD OneFlow™ LST acquired on a 10-color BD FACSLyric™ flow 
cytometer (4-Blue 3-Red 3-Violet) using BD FACSuite™ Clinical 
application v1.3† and the OneFlow LST assay. The BD OneFlow™ 
reference system on BD FACSCanto™ II comprises BD FACSDiva™ 
CS&T IVD Beads, BD OneFlow™ Setup Beads, BD® FC Beads 8-
Color Kit for BD OneFlow™ Assays, and BD OneFlow™ LST 
acquired on a BD FACSCanto™ II flow cytometer (4-2H-2V) using 
BD FACSDiva™ software v8.0.2 and the OneFlow LST template. A 
total of 98 PB specimens, 26 BM specimens and 16 LN specimens were 
enrolled in the study. Specimens were collected in the anticoagulants 
shown. See Table 5.

† A regression study was performed, demonstrating equivalence between 
BD FACSuite™ Clinical application v1.3 and v1.4.

Table 5 Anticoagulants used to collect specimens

Specimen type

Anticoagulant

EDTA Heparin

PB 72 26

BM 23 3
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For PB, BM, and LN specimens, the first wash step was started within 
23, 24, or 23 hours of collection, respectively. Stained PB, BM, and LN 
samples were acquired within 50, 48, or 31 minutes of final 
resuspension, respectively. Samples were identified as being 
“Abnormal” (abnormal for B cells, T cells, or NK cells) or “Normal” 
(normal for T cells, B cells, and NK cells) using the two systems, and 
compared.

Agreement was calculated as follows:
Overall % agreement = ((a+d)/(a+b+c+d))×100
Positive % agreement = (a/(a+c))×100
Negative % agreement = (d/(d+b))×100

wherein,
a = number of samples “Abnormal” for both systems,
b = number of samples “Abnormal” on the BD FACSLyric™ flow cytometer but “Normal” on the 
BD FACSCanto™ II flow cytometer,
c = number of samples “Normal” on the BD FACSLyric™ flow cytometer but “Abnormal” on the 
BD FACSCanto™ II flow cytometer,
d = number of samples “Normal” for both systems.

The results for all cell types are shown in Table 6.

Overall % agreement is 100%. The lower 95% confidence limit is 
97.88%.

Table 6 Agreement for all cells being “Abnormal” or “Normal”

Comparator method 
(BD FACSCanto™ II flow 

cytometer

Abnormal Normal Total

Investigational 
method 
(BD FACSLyric™ 
flow cytometer)

Abnormal 63 0 63

Normal 0 77 77

Total 63 77 140
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The positive agreement for “Abnormal” (abnormal for B cells, T cells, 
and NK cells) is 100%. The negative agreement for “Normal” (normal 
for T cells, B cells, and NK cells) is 100%. 

The results for B cells are shown in Table 7.

Overall % agreement is 100%. The lower 95% confidence limit is 
97.88%.

The positive agreement for “Abnormal” (abnormal for B cells) is 
100%. The negative agreement for “Normal” (normal for B cells) is 
100%. 

The results for T cells are shown in Table 8.

Table 7 Agreement for B cells being “Abnormal” or “Normal”

Comparator method 
(BD FACSCanto™ II flow 

cytometer

Abnormal Normal Total

Investigational 
method 
(BD FACSLyric™ 
flow cytometer)

Abnormal 52 0 52

Normal 0 88 88

Total 52 88 140

Table 8 Agreement for T cells being “Abnormal” or “Normal”

Comparator method 
(BD FACSCanto™ II flow 

cytometer

Abnormal Normal Total

Investigational 
method 
(BD FACSLyric™ 
flow cytometer)

Abnormal 9 0 9

Normal 0 131 131
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Overall % agreement is 100%. The lower 95% confidence limit is 
97.88%.

The positive agreement for “Abnormal” (abnormal for T cells) is 
100%. The negative agreement for “Normal” (normal for T cells) is 
100%. 

The results for NK cells are shown in Table 9.

Overall % agreement is 100%. The lower 95% confidence limit is 
97.88%.

The positive agreement for “Abnormal” (abnormal for NK cells) is 
100%. The negative agreement for “Normal” (normal for NK cells) is 
100%. 

Total 9 131 140

Table 9 Agreement for NK cells being “Abnormal” or “Normal”a

a. NK cell malignancies are rare, therefore the expected number of samples is very low.

Comparator method 
(BD FACSCanto™ II flow 

cytometer

Abnormal Normal Total

Investigational 
method 
(BD FACSLyric™ 
flow cytometer)

Abnormal 2 0 2

Normal 0 138 138

Total 2 138 140

Table 8 Agreement for T cells being “Abnormal” or “Normal”

Comparator method 
(BD FACSCanto™ II flow 

cytometer

Abnormal Normal Total
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Equivalency (BD FACSLyric™ flow cytometer)

A quantitative assessment of the indicated cell populations, expressed 
as a percentage of another cell population, was performed for each 
evaluable specimen enrolled in the method comparison study. 
Specimens were analyzed using the BD OneFlow™ system on the 
BD FACSLyric™ flow cytometer and the BD FACSCanto™ II flow 
cytometer as described previously.

The mean bias for the percentages of the indicated cell populations 
determined on the BD FACSLyric™ flow cytometer versus the 
BD FACSCanto™ II flow cytometer was calculated. See Table 10.

The results of the method comparison and equivalency studies indicate 
that the two systems are substantially equivalent.

Table 10 Summary of mean bias for subset percentages

Population
No. of 

samples Mean bias
Lower 95% CL 
of mean bias

Upper 95% CL 
of mean bias

Leukocytes (%SSC singlets) 134 –0.27 –0.73 0.19

Lymphocytes (%Leukocytes) 134 –0.63 –1.2 –0.06

T cells (%Lymphocytes) 134 –0.17 –0.58 0.24

CD4+CD8– cells (%T cells) 134 –0.53 –1.03 –0.04

CD8+CD4– cells (%T cells) 134 0.2 –0.41 0.81

B cells (%Lymphocytes) 134 –0.26 –0.72 0.19

sIgκ+ cells (%B cells) 134 –1.19 –2.1 –0.29

sIgλ+ cells (%B cells) 134 0.7 0.02 1.38

NK cells (%Lymphocytes) 134 0.45 –0.07 0.98



43

BD FACSCanto™ II Flow Cytometer

Precision studies for the reproducibility and repeatability of the 
BD OneFlow™ LST were performed at BD Biosciences laboratories in 
San Jose, CA.

Reproducibility (BD FACSCanto™ II flow cytometer)

Two operators performed two separate runs per day over a period of 
eight days, alternating the runs on two BD FACSCanto™ II flow 
cytometers. For each run, duplicate samples of BD Multi-Check™ 
Control were stained using three lots of BD OneFlow™ LST by each 
operator, and then acquired and analyzed using the OneFlow LST 
template in BD FACSDiva™ software. Nine cell populations were 
identified as being a percentage of the cell populations indicated in 
Table 11. The reproducibility of the subset percentages was calculated 
for each cell population. Reproducibility comprises four components: 
operator/instrument-to-operator/instrument, lot-to-lot, run-to-run, and 
day-to-day reproducibility.

Table 11 Reproducibility of subset percentages

Population Mean SDa
Upper 95% 
CLb of SD %CVc

Upper 95% 
CL of %CV

Leukocytes (%SSC Singlets) 100.0 0.01 0.03 0.01 0.03

Lymphocytes (%Leukocytes) 37.9 0.5 1.1 1.2 2.9

T cells (%Lymphocytes) 70.3 0.2 0.3 0.3 0.5

CD4+CD8– cells (%T cells) 63.4 0.5 1.5 0.8 2.4

CD8+CD4– cells (%T cells) 25.1 1.1 3.2 4.4 12.8

B cells (%Lymphocytes) 14.8 0.2 1.0 1.5 6.5

NK cells (%Lymphocytes) 14.8 0.3 0.8 1.9 5.6

smIgκ+ cells (%B cells) 59.4 0.2 3.1 0.3 5.2

smIgλ+ cells (%B cells) 40.6 0.2 2.8 0.4 6.8
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Repeatability (BD FACSCanto™ II flow cytometer)

Two operators performed two separate runs per day over a period of 
eight days, alternating the runs on two BD FACSCanto™ II flow 
cytometers. For each run, duplicate samples of BD Multi-Check™ 
Control were stained using three lots of BD OneFlow™ LST by each 
operator, and then acquired and analyzed using the OneFlow LST 
template in BD FACSDiva™ software. Nine cell populations were 
identified as being a percentage of the cell populations indicated in 
Table 12. The within-run precision (tube-to-tube repeatability) of the 
subset percentages was calculated for each of the cell populations.

a. SD = Standard deviation
b. CL = Confidence limit
c. %CV = Coefficient of variation

Table 12 Repeatability of subset percentages

Population Mean SD
Upper 95% 

CL of SD %CV
Upper 95% 
CL of %CV

Leukocytes (%SSC Singlets) 100.0 0.03 0.03 0.03 0.03

Lymphocytes (%Leukocytes) 37.9 0.5 0.5 1.3 1.4

T cells (%Lymphocytes) 70.3 0.4 0.4 0.5 0.6

CD4+CD8– cells (%T cells) 63.4 0.5 0.6 0.8 0.9

CD8+CD4– cells (%T cells) 25.1 0.7 0.8 3.0 3.2

B cells (%Lymphocytes) 14.8 0.3 0.3 1.8 2.0

NK cells (%Lymphocytes) 14.8 0.3 0.3 2.1 2.3

smIgκ+ cells (%B cells) 59.4 0.8 0.8 1.3 1.4

smIgλ+ cells (%B cells) 40.6 0.8 0.8 1.9 2.1
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Method comparison (BD FACSCanto™ II flow cytometer)

A side-by-side comparison study between the BD OneFlow™ LST 
system on the BD FACSCanto™ II flow cytometer and the 
EuroFlow LST system on the BD FACSCanto™ II flow cytometer was 
performed at 3 external clinical sites. The BD OneFlow™ LST system 
comprises BD OneFlow™ Setup Beads, BD® FC Beads for 
compensation, and the BD OneFlow™ LST reagent. The 
EuroFlow LST reference system comprises Sphero™ Rainbow 
calibration particles (8 peaks), single color stained cells plus 
BD® Multicolor CompBeads for compensation, and the EuroFlow LST 
reagent cocktail. Both methods used BD FACSDiva™ CS&T IVD 
beads to perform instrument quality control. Abnormal mature 
lymphocyte populations from 81 patients with B-cell malignancies, 
35 patients with T-cell malignancies, and 6 patients with NK-cell 
malignancies were identified using the two systems, and compared. In 
addition, 9 samples were identified as being from other lineages, for 
example, plasma cell disorders or bi-phenotypic samples. Cell 
populations from 76 negative samples, including 19 healthy donors, 
were identified using the two systems. A total of 123 PB specimens, 
53 BM specimens, and 31 fresh LN specimens were enrolled in the 
study. PB and BM specimens were stained within 24 hours of 
collection. LN specimens were stained within 6 hours of collection. All 
stained samples were acquired within 1 hour of staining. Samples were 
identified as being “Follow-up needed” or “No follow-up needed” 
using the two systems, and compared.

Agreement was calculated as follows:
Overall % agreement = ((a+d)/(a+b+c+d))×100

wherein,
a = number of samples “Follow-up needed” for both systems,
b = number of samples “Follow-up needed” for the BD OneFlow™ system but “No follow-up 
needed” for the EuroFlow system,
c = number of samples “No follow-up needed” for the BD OneFlow™ system but “Follow-up 
needed” for the Euroflow system, and
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d = number of samples “No follow-up needed” for both systems.

The results for all cell types are shown in Table 13.

Overall % agreement is 100%. The lower 95% confidence limit is 
98.6%.

The results for T cells are shown in Table 14.

Table 13 Agreement for all cells being “Follow-up needed” or “No follow-up 
needed”

Comparator method 
(Euroflow LST cocktail)

Follow-up 
needed

No follow-up 
needed

Total

Investigational 
method 
(BD OneFlow™ LST)

Follow-up 
needed

131 0 131

No follow-up 
needed

0 76 76

Total 131 76 207
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Overall % agreement is 100%. The lower 95% confidence limit is 
98.6%.

The results for B cells are shown in Table 15.

Overall % agreement is 100%. The lower 95% confidence limit is 
98.6%.

Table 14 Agreement for T cells being “Follow-up needed” or “No follow-up 
needed”

Comparator method 
(Euroflow LST cocktail)

Follow-up 
needed

No follow-up 
needed

Total

Investigational 
method 
(BD OneFlow™ LST)

Follow-up 
needed

35 0 35

No follow-up 
needed

0 172 172

Total 35 172 207

Table 15 Agreement for B cells being “Follow-up needed” or “No follow-up 
needed”

Comparator method 
(Euroflow LST cocktail)

Follow-up 
needed

No follow-up 
needed

Total

Investigational 
method 
(BD OneFlow™ LST)

Follow-up 
needed

81 0 81

No follow-up 
needed

0 126 126

Total 81 126 207
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The results for NK cells are shown in Table 16.

Overall % agreement is 100%. The lower 95% confidence limit is 
98.6%.

Equivalency (BD FACSCanto™ II flow cytometer)

Peripheral blood, bone marrow, and lymph node specimens collected at 
3 external clinical laboratories were obtained from patients with T-cell, 
B-cell, or NK-cell abnormalities, or with no hematological 
abnormalities. Specimens were analyzed using the BD OneFlow™ LST 
system and the EuroFlow LST system described previously.

The bias for leukocytes identified as being a percentage of SSC singlets 
is summarized in Table 17.

Table 16 Agreement for NK cells being “Follow-up needed” or “No follow-up 
needed”a

a. NK cell malignancies are rare, therefore the expected number of samples is very low.

Comparator method 
(Euroflow LST cocktail)

Follow-up 
needed

No follow-up 
needed

Total

Investigational 
method 
(BD OneFlow™ LST)

Follow-up 
needed

6 0 6

No follow-up 
needed

0 201 201

Total 6 201 207

Table 17 Summary of bias for Leukocytes (%SSC singlets)

Population
No. of 

samples
Average 

bias
Lower 95% CL 
of average bias

Upper 95% CL 
of average bias

Leukocytes (%SSC singlets) 207 –1.1% –1.7% –0.6%
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The remaining eight cell populations were identified as being a 
percentage of the cell populations indicated in Table 18. Deming 
regression statistics indicate that the results obtained using the two 
systems are substantially equivalent.

Table 18 Equivalency of the BD OneFlow™ system to the EuroFlow system

Population
No. of 

samples Intercept Slope
Lower 95% 
CL of slope

Upper 95% 
CL of slope

Lymphocytes 
(%Leukocytes)

207 –0.68 1.01 1.00 1.02

T cells (%Lymphocytes) 207 1.07 0.99 0.98 1.00

CD4+CD8– cells 
(%T cells)

207 –0.64 1.01 1.00 1.02

CD8+CD4– cells 
(%T cells)

207 –0.45 1.00 0.99 1.01

B cells (%Lymphocytes) 207 –0.01 1.00 0.99 1.00

NK cells 
(%Lymphocytes)

207 0.81 0.92 0.84 1.00

smIgκ+ cells (%B cells) 206a

a. One patient specimen had 0 and 2 B-cell events for the two systems, respectively. Since smIgκ and smIgλ are 
defined as a percentage of B-cell events in this study, they could not be defined in one system, and therefore could 
not be included in the quantitative analysis for smIgκ and smIgλ for that specimen.

2.24 1.00 0.97 1.02

smIgλ+ cells (%B cells) 206a –2.04 1.00 0.98 1.03



50

11. TROUBLESHOOTING

Problems with cell preparation or staining

Problems using BD OneFlow LST on BD FACSLyric flow cytometers:

Problem Possible Cause Solution

The resolution 
between debris and 
lymphocytes is poor.

Specimen was poorly lysed. Prepare and stain another specimen.

Specimen is of poor quality. Check cell viability.

Specimen is too old. Obtain a new specimen and stain it 
immediately.

Staining is dim or 
fading.

Cell concentration was too 
high at the staining step.

Check the cell concentration and 
adjust as needed.

Washed specimen was not 
stained within 30 minutes of 
the last wash.

Repeat staining with a freshly 
prepared specimen.

BD OneFlow™ LST was 
exposed to light for too long.

Repeat staining with a new tube of 
BD OneFlow™ LST.

Stained cells were stored too 
long before acquiring them.

Repeat staining with a fresh specimen 
and acquire it promptly.

Few or no cells are 
recorded.

Cell concentration was too 
low.

Centrifuge specimen and resuspend it 
at a higher concentration. Repeat 
staining and acquisition.

Cytometer is malfunctioning. Troubleshoot the instrument. See the 
cytometer IFU for more information.

Problem Possible Cause Solution

Not enough cells of 
interest are acquired.

Cell concentration was too 
low.

Centrifuge specimen and resuspend it 
at a higher concentration. Repeat 
staining and acquisition.

The default setting of 
100,000 events acquired is 
too low.

Change the number of events 
acquired. Repeat staining and 
acquisition. See the BD OneFlow™ 
LST Application Guide For the 
BD FACSLyric™ Flow Cytometer.
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Problems using BD OneFlow LST on BD FACSCanto II flow cytometers:

The FSC-A vs SSC-A 
dot plot is abnormal.

Cytometer needs adjusting. Contact BD Biosciences.

The csv file and report 
are not exported 
automatically.

The reagent lot number and 
expiration date were not 
added to the Library.

1. Add the reagent lot number and 
expiration date to the Library.

2. Export the csv file and the report 
PDF manually. See the 
BD FACSLyric™ Clinical System 
Instructions For Use.

Problem Possible Cause Solution

The resolution 
between debris and 
lymphocytes is poor.

Instrument settings are 
inappropriate.

Follow proper instrument setup 
procedures. See the Instrument Setup 
Guide for BD OneFlow™ Assays.

Some of the dot plots 
are dimmed.

FSC-H and SSC-H were not 
selected when the 
application settings were 
created.

Check that FSC-H and SSC-H are 
selected on the Parameters tab of the 
Inspector.

The barcode on the 
BD OneFlow™ LST 
tube label cannot be 
scanned.

The barcode on the tube 
label has been compromised.

Scan the barcode on the 
BD OneFlow™ LST pouch label into 
the Product ID keyword field in the 
Experiment Layout. Next, manually 
enter a semicolon (;) followed by the 
six-digit tube-specific ID, found 
adjacent to the barcode on the tube 
label, after the last digit of the 
barcode.

The dot plots on the 
worksheets are 
missing or the dot 
plots do not have 
gates.

The template did not import 
correctly.

1. Close the current experiment.

2. Create a new experiment.

3. Re-import the BD OneFlow™ LST 
template.

Problem Possible Cause Solution
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WARRANTY

Unless otherwise indicated in any applicable BD general conditions of sale for 
non-US customers, the following warranty applies to the purchase of these 
products.

THE PRODUCTS SOLD HEREUNDER ARE WARRANTED ONLY TO CONFORM TO THE 
QUANTITY AND CONTENTS STATED ON THE LABEL OR IN THE PRODUCT LABELING 
AT THE TIME OF DELIVERY TO THE CUSTOMER. BD DISCLAIMS HEREBY ALL OTHER 
WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR ANY PARTICULAR PURPOSE AND 
NONINFRINGEMENT. BD’S SOLE LIABILITY IS LIMITED TO EITHER REPLACEMENT OF 
THE PRODUCTS OR REFUND OF THE PURCHASE PRICE. BD IS NOT LIABLE FOR 
PROPERTY DAMAGE OR ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES, 
INCLUDING PERSONAL INJURY, OR ECONOMIC LOSS, CAUSED BY THE PRODUCT.

Some of the keywords 
are missing from the 
statistics box in the 
analysis worksheet.

BD FACSDiva™ software 
did not import all of the 
keywords into the panel 
template.

1. In the Browser, set the current 
tube pointer to the tube that you 
are analyzing.

2. Navigate to the analysis 
worksheet.

3. Right-click the statistics box and 
select Edit Stats View.

4. In the Header tab, select the All 
checkbox.

5. Click OK.

The statement, For in 
vitro diagnostic use, 
does not appear in the 
footer of the analysis 
worksheet when it is 
printed.

The paper margins in the 
printer settings were 
changed.

1. From the BD FACSDiva™ 
software menu bar, select File > 
Page Setup.

2. Ensure that all of the margins are 
set to 2.54 cm or 1 inch, 
depending on your default 
standards.

3. Click OK.

Problem Possible Cause Solution
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TRADEMARKS

BD, the BD Logo, FACS, FACSCanto, FACSDiva, FACSLyric, 
FACSuite, Horizon, OneFlow and Vacutainer are trademarks of 
Becton, Dickinson and Company or its affiliates. All other trademarks 
are the property of their respective owners. © 2021 BD. All rights 
reserved.
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CONTACT INFORMATION

Becton, Dickinson and Company
BD Biosciences
2350 Qume Drive
San Jose, CA 95131 USA

Benex Limited
Pottery Road, Dun Laoghaire
Co. Dublin, Ireland
Tel +353.1.202.5222
Fax +353.1.202.5388

BD Biosciences
European Customer Support
Tel +32.53.720.600
help.biosciences@bd.com

Australian and New Zealand
Distributors:

Becton Dickinson Pty Ltd.
66 Waterloo Rd
Macquarie Park NSW 2113
Australia

Becton Dickinson Limited
14B George Bourke Drive 
Mt Wellington, Auckland 1060
New Zealand

For technical support, contact: 

bdbiosciences.com
ClinicalApplications@bd.com
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